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Important Information

Warranty
The AT-GPIB/TNT (PnP) hardware is warranted against defects in materials and workmanship for a period of two years
from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair
or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability
of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any
action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National
Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse,
misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Trademarks
NAT4882®, NI-488®, Turbo488®, NI-488.2™, NI-488.2M™, and TNT4882C™ are trademarks of National Instruments
Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or
clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user
or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC Radio Frequency Interference

Class B Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict
accordance with the instructions in this manual, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the
Canadian Department of Communications (DOC). This equipment has been tested and found to comply
with the following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.

• Consult the dealer or an experienced radio/TV technician for help.

Notices to User: Changes or modifications not expressly approved by National Instruments could void
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of
suitable quality and construction. National Instruments used such cables to test this
device and provides them for sale to the user. The use of inferior or nonshielded
interface cables could void the user’s authority to operate the equipment under the
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home

Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.
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About

This

Manual

This manual contains instructions on how to install and configure the

National Instruments AT-GPIB/TNT (PnP) interface and the NI-488.2M

software for Windows NT.

This manual assumes that you are already familiar with the Windows NT

operating system.

How to Use the Manual Set

NI-488.2M User
Manual for

Windows 95
and Windows NT

Application
Development
and Examples

NI-488.2M Function
Reference Manual

for Win32

Function
and Routine
Descriptions

Novice
Users

Experienced
Users

Getting Started
Manual

Installation and
Configuration

Use this manual to install and configure your AT-GPIB/TNT (PnP) board

and the NI-488.2M software for Windows NT.
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Use the NI-488.2M User Manual for Windows 95 and Windows NT to

learn the basics of GPIB and how to develop an application program.

You can also use the manual as a reference for debugging information

and detailed examples.

Use the NI-488.2M Function Reference Manual for Win32 for specific

NI-488 function and NI-488.2 routine information, such as format,

parameters, and possible errors.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what

you need to get started, and briefly describes the

AT-GPIB/TNT (PnP) board and the NI-488.2M software.

• Chapter 2, GPIB Software Installation, contains instructions on how

to install the NI-488.2M software for Windows NT version 4.0 or

higher.

• Chapter 3, Plug and Play Software Installation, contains instructions

on how to install the ISA Plug and Play software on your system.

• Chapter 4, Hardware Installation, contains instructions on how to

install your AT-GPIB/TNT (PnP) board.

• Chapter 5, Software Configuration, contains instructions on how to

configure the NI-488.2M software for Windows NT.

• Chapter 6, Verify the Installation, describes how to verify the

hardware and software installation.

• Chapter 7, Begin to Use the GPIB Software, helps you get started

with the NI-488.2M software for Windows NT.

• Appendix A, Hardware Specifications, describes the electrical,

physical, and environmental characteristics of the

AT-GPIB/TNT (PnP) board and the recommended operating

conditions.

• Appendix B, Troubleshooting and Common Questions, contains

troubleshooting information and the answers to common questions.

• Appendix C, Customer Communication, contains forms you can use

to request help from National Instruments or to comment on our

products and manuals.
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• The Glossary contains an alphabetical list and description of terms

that appear in this manual, including abbreviations, acronyms, metric

prefixes, mnemonics, and symbols.

Conventions Used in This Manual

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box

options to a final action. The sequence File»Page Setup»Options»

Substitute Fonts directs you to pull down the File menu, select the Page

Setup item, select Options, and finally select the Substitute Fonts

options from the last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog

boxes, dialog box buttons or options, icons, windows, or LEDs.

bold italic Bold italic text denotes a note, caution, or warning.

bold monospace Bold text in this font denotes the messages and responses that the

computer automatically prints to the screen. This font also emphasizes

lines of code that are unique from the other examples.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987

IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which define the

GPIB.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key

concept. This font also denotes text for which you supply the appropriate

word or value, as in Windows 3.x.

italic monospace Italic text in this font denotes that you must supply the appropriate words

or values in the place of these items.

monospace Text in this font denotes text or characters that you should literally enter

from the keyboard, sections of code, programming examples, and syntax

examples. This font can also denote the proper names of disk drives,

paths, directories, programs, subprograms, subroutines, device names,

functions, operations, variables, filenames and extensions, and for

statements and comments taken from programs.
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Related Documentation

The following documents contain information that you may find helpful

as you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,

Protocols, and Common Commands

• Microsoft Windows NT System Guide, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products

and manuals. We are interested in the applications you develop with our

products, and we want to help if you have problems with them. To make

it easy for you to contact us, this manual contains comment and

configuration forms for you to complete. These forms are in Appendix C,

Customer Communication, at the end of this manual.



© National Instruments Corporation 1-1 AT-GPIB/TNT (PnP) for Windows NT

Introduction
1

Chapter

This chapter explains how to use this manual, lists what you need to get

started, and briefly describes the AT-GPIB/TNT (PnP) board and the

NI-488.2M software.

How to Use This Manual

Yes

No

Chapter 6

Chapter 7

User Manual and
Function Reference

Manual
Write Application Programs

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the GPIB Software

Configure the Software

Install the Hardware

Install the Plug and Play Software

Verify the Installation

Review Programming
Considerations

Troubleshooting

Begin to Use the GPIB Software

Chapter 2

Chapter 3

Chapter 4

Chapter 5
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What You Need to Get Started

❑ AT-GPIB/TNT (PnP)

❑ The following 3.5 in., high density (1.44 MB) disks, which your kit

contains:

GPIB Software for Windows NT (Setup Disk)

GPIB Software for Windows NT (NI-488.2M Software)

❑ Windows NT version 4.0 or higher installed on your computer

Hardware Description

The AT-GPIB/TNT (PnP) hardware complies with the Plug and Play ISA

Standard. It is completely software configurable. The

AT-GPIB/TNT (PnP) board, equipped with the TNT4882C ASIC, uses

the NI-488.2M software to transform any ISA or EISA bus computer into

a fully functional GPIB Talker/Listener/Controller that has complete

communications and bus management capability. The TNT4882C chip

combines the circuitry of the NAT4882 ASIC, the Turbo488

performance-enhancing ASIC, and GPIB transceivers to create a

single-chip IEEE 488.2 Talker/Listener/Controller interface. The

TNT4882C also implements the HS488 high-speed protocol, which

increases the maximum data transfer rate of the AT-GPIB/TNT (PnP) to

2.2 Mbytes/s, when used in an ISA bus. For more information about

HS488, refer to Chapter 7, GPIB Programming Techniques, in the

NI-488.2M User Manual for Windows 95 and Windows NT.

The AT-GPIB/TNT (PnP) board is fully compatible with all versions of

AT-GPIB hardware. You can use standard GPIB cables to connect the

AT-GPIB/TNT (PnP) with up to 14 instruments. If you want to use more

than the maximum number of instruments, you can order a bus extender

or expander from National Instruments. Refer to Appendix A, Hardware

Specifications, for more information about the GPIB hardware

specifications and operating conditions.



Chapter 1    Introduction

© National Instruments Corporation 1-3 AT-GPIB/TNT (PnP) for Windows NT

Software Description

The NI-488.2M software for Windows NT includes a loadable

Windows NT kernel device driver and supporting utilities, including the

following components:

• Device driver

• Diagnostic test

• Configuration utility

• Interactive control program

• Utilities for software development and debugging

• Language interface library for Microsoft Visual C/C++,

Borland C/C++, and Visual Basic

• Virtual device driver and special DOS and Windows 3 drivers for

running existing NI-488.2 for DOS and Windows 3 applications

under Windows NT

• Example programs that use NI-488 functions and NI-488.2 routines

For a detailed list of files, refer to the NI-488.2M User Manual for

Windows 95 and Windows NT.

Optional Programming Tools

Your kit includes the NI-488.2M software for Windows NT. In addition,

you can order the LabWindows
®
/CVI or LabVIEW software from

National Instruments.

LabWindows/CVI is an interactive ANSI C development environment for

building test and measurement and instrument control systems. It

includes interactive code-generation tools and a graphical editor for

building custom user interfaces. It also includes built-in libraries for

IEEE 488.2, VXI, RS-232 control, and plug-in data acquisition. When

you order LabWindows/CVI, you also get hundreds of complete

instrument drivers, which are modular, source-code programs that handle

the communication with your instrument so that you do not have to learn

the programming details.
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LabVIEW is a complete programming environment that departs from the

sequential nature of traditional programming languages and features a

graphical programming environment. It includes all the tools needed for

instrument control, data acquisition, analysis, and presentation.

LabVIEW also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact

National Instruments.
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GPIB Software Installation
2

Chapter

This chapter contains instructions on how to install the NI-488.2M

software for Windows NT version 4.0 or higher.

Note: The AT-GPIB/TNT (PnP) is supported only under Windows NT

version 4.0 or higher.

Before you install and configure the hardware, complete the following

steps to install the NI-488.2M software for Windows NT:

1. Log onto your Windows NT system using the Administrator

account. This installation program must have Administrator

privileges because the program modifies the configuration registry of

your computer.

2. Insert the GPIB Software for Windows NT (Setup Disk) into an

unused drive.

3. Select Run... from the Start menu.

4. Type the following command in the dialog box:

x:\setup

where x is the letter of the drive containing the distribution disk

(usually a or b).

The software installation begins with the following screen.
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Figure 2-1.  NI-488.2M Software for Windows NT Installation Screen

The setup program takes you through the necessary steps to install

the NI-488.2M software. For help during the installation, click on the

Help button. To exit the setup program at any time, click on the Exit

button.

When the setup program has finished copying the software to your

computer, it attempts to start the NI-488.2M driver. If the setup

program cannot start the driver, it instructs you to restart

Windows NT, which forces the driver to load.

Next, you need to enable support for ISA Plug and Play hardware in your

system. Proceed to Chapter 3, Plug and Play Software Installation.
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Plug and Play

Software Installation
3

Chapter

This chapter contains instructions on how to install the ISA Plug and Play

software on your system.

The AT-GPIB/TNT (PnP) is an ISA Plug and Play interface. By default,

Windows NT 4.0 does not support ISA Plug and Play hardware. For

Windows NT to detect and configure the ISA Plug and Play hardware,

you must enable support for Plug and Play by installing the pnpisa.sys

file. To install the pnpisa.sys file from your Windows NT 4.0

CD-ROM, complete the following steps:

1. Log onto your Windows NT system using the Administrator

account. This installation program must have Administrator

privileges because the program modifies the configuration registry of

your computer.

2. Locate the pnpisa.inf file in the Drvlib\Pnpisa\X86 folder on

the Windows NT 4.0 CD-ROM.

3. Right-click on the pnpisa.inf file and click on the Install button

in the context-sensitive menu that appears.

4. After the installation is complete, restart your computer.

The software installation and enabling of support for ISA Plug and Play

hardware on your system is now complete. Proceed to Chapter 4,

Hardware Installation.
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Hardware Installation
4

Chapter

This chapter contains instructions on how to install your

AT-GPIB/TNT (PnP) board.

Warning: Electrostatic discharge can damage several components on your

AT-GPIB/TNT (PnP) board. To avoid electrostatic damage when you

handle the board, touch the antistatic plastic package to a metal part of

your computer chassis before you remove the board from the package.

Complete the following steps to install your AT-GPIB/TNT (PnP) board:

1. Turn off your computer. Keep the computer plugged in so that it

remains grounded while you install the GPIB hardware.

2. Remove the top cover (or other access panels) to give yourself access

to the computer expansion slots.

3. Find an unused expansion slot in your computer. The

AT-GPIB/TNT (PnP) board requires a 16-bit ISA expansion slot.

4. Remove the corresponding slot cover on the back panel of the

computer.

5. Insert the AT-GPIB/TNT (PnP) board into the slot with the GPIB

connector sticking out of the opening on the back panel, as shown in

Figure 4-1. It might be a tight fit, but do not force the board into

place.
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Figure 4-1.  Installing the AT-GPIB/TNT (PnP) Board

6. Screw the mounting bracket of the AT-GPIB/TNT (PnP) board to the

back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your computer and start Windows NT. Windows NT should

automatically detect the GPIB hardware and display a New

Hardware Found dialog box. After Windows NT detects the

hardware, a System Settings Change dialog box appears. Click on

the Yes button to restart your system.

The AT-GPIB/TNT (PnP) board hardware installation is now complete.

Proceed to Chapter 5, Software Configuration.
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Software Configuration
5

Chapter

This chapter contains instructions on how to configure the NI-488.2M

software for Windows NT.

By default, Windows NT does not configure ISA Plug and Play

hardware. The AT-GPIB/TNT (PnP) board is an ISA Plug and Play board

and must be configured using the NI-488.2M software after you install

the hardware.

The GPIB Control Panel applet is an interactive utility you can use to

examine or modify the configuration of the driver. You must run the

GPIB Control Panel applet before you begin to use the

AT-GPIB/TNT (PnP) board. Complete the following steps to run the

applet:

1. Double-click on the GPIB icon in the Control Panel. To open the

Control Panel, select Start»Settings»Control Panel.

The GPIB Control Panel applet displays a list of all the GPIB boards

and device names.

2. In the GPIB Configuration dialog box, select a GPIB interface from

the GPIB Board list. If you are using only one GPIB interface,

select GPIB0.

3. Click on the Board Type button, select AT-GPIB/TNT (PnP) from

the Board Type list, and click on the OK button.

4. Click on the Configure button to bring up the GPIB Configuration

dialog box, as shown in Figure 5-1. For more information about

GPIB Control Panel applet options, refer to the online help.
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Figure 5-1.  AT-GPIB/TNT (PnP) Configuration Dialog Box

5. In the GPIB Configuration dialog box, click on the Controller

Resources button to set resources for the board.

6. In the AT-GPIB/TNT (Plug and Play) Properties dialog box that

appears, examine the assigned resources. Figure 5-2 shows the

AT-GPIB/TNT(Plug and Play) Properties dialog box. Use the

Setting based on drop-down list and the Change Setting... button to

select conflict free resources. While editing the Setting based on

drop-down list, select either Basic Configuration 0000 or Basic

Configuration 0001, the only two valid basic configurations. The

valid resources are as follows:

a. Reserving a DMA channel is optional. The options for the DMA

channel are 5, 6, 7, or none. To select a different DMA channel,

highlight Direct Memory Access and click on the Change

Setting... button. To set the DMA channel to None, select Basic

Configuration 0001 from the Setting based on drop-down list.

b. Reserving address space is mandatory.

Note: The default I/O range assigned by Windows NT is not valid and must be

changed to a valid value.

To select a base I/O address, highlight Input/Output Range and

click on the Change Setting... button. The AT-GPIB/TNT (PnP)

address space must be in the range of 0x100 to 0x3E0. You must

have 0x20 bytes of contiguous I/O address space. For example,

if you are selecting a base I/O address of 0x2C0, enter 2C0 for
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the start value and enter 2DF for the end value. A base address

value of 2C0 usually works with a GPIB interface.

c. Reserving an IRQ level is mandatory. To select an IRQ level,

highlight Interrupt Request and click on the Change Setting...

button. The options for the IRQ level are 3, 4, 5, 6, 7, 9, 11, 12,

14, or 15. An IRQ level of 11 usually works with a GPIB

interface.

Figure 5-2.  AT-GPIB/TNT (Plug and Play) Properties Dialog Box

7. When you have changed the hardware settings to valid settings and

there are no resource conflicts, click on the OK button. When the

Creating a Forced Configuration dialog box appears, click on the

Yes button to confirm the setting of the selected resources.

8. After you configure your software, restart Windows NT and proceed

to Chapter 6, Verify the Installation.
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Verify the Installation
6

Chapter

This chapter describes how to verify the hardware and software

installation.

You can use the Diagnostic utility, installed with your NI-488.2M

software, to test the hardware and software installation. The Diagnostic

utility verifies that your hardware and software are functioning properly

and that the configuration of your GPIB interfaces does not conflict with

anything else in your system.

To run the Diagnostic utility, select the Diagnostic item under

Start»Programs»NI-488.2M Software for Windows NT.

When you have started the Diagnostic utility, test your GPIB interfaces

by clicking on the Test All button. If the Diagnostic utility test is

successful, it places a check mark next to the interface and changes its

status from untested to passed. If the Diagnostic utility test fails, it

puts an X next to the interface, and changes its status from untested to

failed. Figure 6-1 shows the Diagnostic dialog box after it has tested

some GPIB interfaces. The AT-GPIB/TNT (PnP) board appears as

AT-GPIB/TNT in the Diagnostic dialog box.
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Figure 6-1.  Diagnostic Utility after Testing

To get details on any of the tested GPIB interfaces, select the interface

and click on the Details button. For each failed GPIB interface, select it

and click on the Details button to get a description of the failure

encountered. Use that information and the information in Appendix B,

Troubleshooting and Common Questions, to troubleshoot the problem.

There is also extensive troubleshooting information in the Diagnostic

utility online help.
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Chapter

This chapter helps you get started with the NI-488.2M software for

Windows NT.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and

NI-488.2 routines interactively and see the values the function calls

return. You can use this utility to do the following:

• Verify GPIB communication with your device quickly and easily.

• Learn the NI-488 functions and NI-488.2 routines before you write

your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

To run the Win32 Interactive Control utility, select the Win32

Interactive Control item under Start»Programs»NI-488.2M Software

for Windows NT.

This utility includes extensive online help. For more information about

the Win32 Interactive Control utility, refer to the NI-488.2M User

Manual for Windows 95 and Windows NT.
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Introduction to the GPIB Spy Utility

Included with the NI-488.2M software is GPIB Spy, a Win32 utility that

you can use to monitor NI-488.2M calls made by Win32, Win16, and

DOS GPIB applications. You can use GPIB Spy to do the following:

• Capture information about NI-488 functions and NI-488.2M routines

as your GPIB applications invoke them.

• Display captured information, including, but not limited to, input and

output parameter values, I/O buffer contents, and return values.

• Save, restore, and print captured information.

To run GPIB Spy, select the GPIB Spy item under

Start»Programs»NI-488.2M Software for Windows NT.

For more information about the GPIB Spy utility, refer to Chapter 5,

GPIB Spy Utility, in the NI-488.2M User Manual for Windows 95 and

Windows NT, or use the GPIB Spy context-sensitive online help.

General Programming Considerations

As you begin developing your Win32 NI-488.2M application, remember

the following points:

• For your C/C++ application, you must include the NI-488.2M header

file in your source code.

• You can access the NI-488.2M software through the 32-bit DLL,

gpib-32.dll, either by linking with one of the language interfaces

provided with the NI-488.2M software, or by using direct DLL entry

from any programming environment.

• Several sample GPIB applications are included with the NI-488.2M

software. Use these as a guide for your own application

development.

For information about choosing a programming method, developing your

application, or compiling and linking, refer to the NI-488.2M User

Manual for Windows 95 and Windows NT. For detailed information about

each NI-488 function and NI-488.2 routine, refer to the NI-488.2M

Function Reference Manual for Win32.
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Running Existing DOS and Windows GPIB Applications

You can run existing DOS and Windows GPIB applications under

Windows NT by using the GPIB Virtual Device Driver, gpib-vdd.dll,

which is included with your NI-488.2M software.

To run DOS GPIB applications, load the special GPIB device driver

gpib-nt.com instead of gpib.com, which you normally use with DOS.

When you install the NI-488.2M software, the installation program

copies gpib-nt.com into a new subdirectory called doswin16. To

use gpib-nt.com, you must modify your config.nt file to

load gpib-nt.com whenever a DOS application runs. The config.nt

file is located in your winnt\system32 directory, where winnt is your

Windows NT directory, for example, c:\windows. To load

gpib-nt.com, add the following line to your config.nt file:

device=path\doswin16\gpib-nt.com

where path is the directory where you installed the NI-488.2M software

(the default installation directory is c:\gpib-nt).

To run 16-bit Windows GPIB applications, the system uses the special

GPIB dynamic link library, gpib.dll. When you install the NI-488.2M

software, the installation program copies gpib.dll into the

winnt\system32 directory, where winnt is your Windows NT

directory, for example c:\windows. As long as gpib.dll is in your

Windows NT directory, your system automatically accesses gpib.dll

when you launch a 16-bit Windows GPIB application.
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Hardware Specifications
A

Appendix

This appendix describes the electrical, physical, and environmental

characteristics of the AT-GPIB/TNT (PnP) board and the recommended

operating conditions.

Table A-1.  Electrical Characteristics for the AT-GPIB/TNT (PnP)

Characteristic Specification

Maximum GPIB Transfer Rates:

   3-Wire (IEEE 488)

High Speed (HS488):

   In ISA computer

1.5 Mbytes/s*

2.2 Mbytes/s*

Power Requirement

(from PC AT I/O channel)

+5 VDC    120 mA   Typical

                  200 mA  Maximum

* Actual speed may vary considerably from speed shown due to

system and instrumentation capabilities.

Table A-2.  Physical Characteristics for the AT-GPIB/TNT (PnP)

Characteristic Specification

Dimensions 10.67 cm by 16.51 cm

(4.2 in. by 6.5 in.)

I/O Connector IEEE 488 Standard 24-Pin



Appendix A    Hardware Specifications

AT-GPIB/TNT (PnP) for Windows NT A-2 © National Instruments Corporation

Table A-3.  Environmental Characteristics for the AT-GPIB/TNT (PnP)

Characteristic Specification

Operating Environment:

   Component Temperature

   Relative Humidity

0° to 55° C

10% to 90%, Noncondensing

Storage Environment:

   Temperature

   Relative Humidity

-20° to 70° C

5% to 90%, Noncondensing

EMI FCC Class B Certified
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Troubleshooting and

Common Questions
B

Appendix

This appendix contains troubleshooting information and the answers to

common questions.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages the Diagnostic

utility generates.

Missing Software Components
This error occurs if the software components that are necessary for the

NI-488.2M software for Windows NT to function correctly are not

present in the system. If you encounter this problem, reinstall the

NI-488.2M software for Windows NT and run the Diagnostic utility

again.

No GPIB Interfaces Present
This error occurs if there are no GPIB interfaces physically present in the

system or if there is a resource conflict with the interfaces that are

installed. If you encounter this problem, use the GPIB Control Panel

applet to examine the installed GPIB interfaces and the resources

assigned to each. Then, run the Diagnostic utility again.

To access this information in the GPIB Control Panel applet, complete

the following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB

icon.

2. Click on the Board Type button and verify that the type of

GPIB interface listed for each logical board name is correct. Click on

the OK button to return to the main dialog box.
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3. Double-click on each board name and verify that the hardware

settings displayed in the dialog box match your actual hardware

settings.

GPIB Cables Need to Be Disconnected
This error occurs if you have any GPIB cables connected to the

GPIB interface. Disconnect all GPIB cables and run the Diagnostic utility

again.

Address Resource Conflict
This error occurs if the address resources assigned to a GPIB interface

conflict with the address resources that other devices in the system are

using. To resolve an address resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a GPIB interface

conflict with the interrupt resources that other devices in the system are

using. To resolve an interrupt resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

DMA Resource Conflict
This error occurs if the DMA resources assigned to a GPIB interface

conflict with the DMA resources that other devices in the system are

using. To resolve a DMA resource conflict, refer to the Resolving

Resource Conflicts section later in this appendix. After you have resolved

the conflict, run the Diagnostic utility again.

Single-Cycle DMA Required
This error occurs if the Diagnostic utility detects that it is unable to

perform demand-mode DMA for the GPIB interface and that you have

not configured the NI-488.2M software to use single-cycle DMA. GPIB

interfaces that use the system DMA controller, such as the

AT-GPIB/TNT (PnP), normally use demand-mode DMA. If you

encounter this error, you should use the GPIB Control Panel applet to
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configure the NI-488.2M software to use single-cycle DMA for all DMA

transfers, and then run the Diagnostic utility again.

To configure the NI-488.2M software to use single-cycle DMA for a

particular GPIB interface, complete the following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB

icon.

2. Double-click on the GPIB interface you want to configure.

3. Make sure that the Use Demand Mode DMA item is unchecked.

NI-488.2M Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to

communicate correctly with the GPIB hardware using the installed

NI-488.2M software. If you encounter this error, shut down your

computer, restart it, and run the Diagnostic utility again. If the problem

persists, reinstall the NI-488.2M software for Windows NT.

Unknown Problem Encountered
This error occurs if an unknown problem is encountered when you try to

execute the Diagnostic utility. If this error occurs, shut down your

computer, restart it, and run the Diagnostic utility again. If the problem

persists, reinstall the NI-488.2M software for Windows NT.

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is

configured to use the same resources as your GPIB interface. The

NI-488.2M driver detects some resource conflicts when it loads. When

the driver detects conflicts as it loads, it records an error message

describing the conflict. You can use the Event Viewer, as described in the

following section, Using Windows NT Diagnostic Tools, to see which

resource is in conflict.

Once you have identified the resource that caused the conflict, use the

GPIB Control Panel applet to reconfigure your GPIB interface so that it

uses conflict-free resources. To help in the selection of conflict-free

resources, Microsoft has provided a utility called Windows NT

Diagnostics. This utility displays a list of the I/O port addresses, interrupt

levels, and DMA channels that are currently being used in your system.

Assign resources that this utility does not list to your GPIB interface.
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To run the Windows NT Diagnostics utility, select

Start»Programs»Administrative Tools»Windows NT Diagnostics.

Using Windows NT Diagnostic Tools

There are many reasons why the NI-488.2M driver might not load. If the

software is not properly installed or if there is a conflict between the

GPIB hardware and the other hardware in the system, the NI-488.2M

driver fails to start. Two Windows NT utilities are useful in determining

the source of the problem:  the Devices applet in the Control Panel, and

the Event Viewer. The following sections describe the information

available through each utility.

Examining NT Devices to Verify the NI-488.2M Installation
To verify whether the NI-488.2M devices are installed correctly (that is,

that the devices are started), select Start»Settings»Control Panel and

double-click on the Devices icon.

This utility lists all of the devices Windows NT detects. Each device has

a status associated with it. If the NI-488.2M driver is installed correctly,

the following lines appear in the list of NT devices:

Device Status Started

GPIB Board Class Driver Started Automatic

GPIB Device Class Driver Started Automatic

You should also see one or more lines similar to the following:

Device Status Started

GPIB Port Driver (AT-GPIB) **** System

GPIB Port Driver (PCI-GPIB) **** System

The GPIB Board Class Driver, the GPIB Device Class Driver, and at least

one of the GPIB Port Drivers listed by the Devices applet should have a

status of Started. If not, refer to the next section, Examining the NT

System Log Using the Event Viewer.

If the GPIB Class Driver lines are not present or at least one GPIB Port

Driver line is not present, the NI-488.2M software is not installed

properly and you must reinstall the NI-488.2M software.
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Examining the NT System Log Using the Event Viewer
Windows NT maintains a system log. If the NI-488.2M driver is unable

to start, it records entries in the system log explaining why it failed to

start. To examine the system log by running the Event Viewer utility,

select Start»Programs»Administrative Tools»Event Viewer.

Events that might appear in the system log include the following:

• The system cannot locate the device file for one or more of the

devices that make up the NI-488.2M driver and an event is logged

that The system cannot find the file specified. In this

case, the NI-488.2M software is incorrectly installed and you must

reinstall the software.

• A conflict exists between the GPIB hardware and the other hardware

in the system. If this is the case, an event is logged that indicates the

nature of the resource conflict. To correct this conflict, reconfigure

the NI-488.2M software. Refer to Chapter 5, Software

Configuration.

Common Questions

How can I determine which version of the NI-488.2M software I have

installed?

To run the Diagnostic utility, choose the Diagnostic item under

Start»Programs»NI-488.2M Software for Windows NT.

How many GPIB interfaces can I configure for use with my

NI-488.2M Software for Windows NT?

You can configure the NI-488.2M Software for Windows NT to

communicate with up to four GPIB interfaces.

How many devices can I configure for use with my NI-488.2M

Software for Windows NT?

The NI-488.2M Software for Windows NT provides a total of 100 logical

devices for applications to use. The default number of devices is 32.
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Are interrupts and DMA required with the NI-488.2M Software for

Windows NT?

Interrupts are required, but DMA is not.

How can I determine if my GPIB hardware and software are

correctly installed?

To run the Diagnostic utility, choose the Diagnostic item under

Start»Programs»NI-488.2M Software for Windows NT.

How do the AT-GPIB/TNT (PnP) and AT-GPIB/TNT+ boards

appear under Board Type in the Diagnostic utility?

For both the AT-GPIB/TNT (PnP) and AT-GPIB/TNT+ the appropriate

Board Type is AT-GPIB/TNT.

Does the AT-GPIB/TNT (PnP) board work under Windows NT

3.5.1?

No, the AT-GPIB/TNT (PnP) board is only supported under

Windows NT version 4.0 or higher.

Does the AT-GPIB/TNT+ board work under Windows NT version

4.0 or higher?

Yes, the AT-GPIB/TNT+ board can be used under Windows NT

version 4.0 or higher, but only with the Controller functionality; the

Analyzer functionality is not currently supported under Windows NT. To

use your AT-GPIB/TNT+ board, follow the instructions in Chapters 2

through 5. In addition to configuring Controller Resources, you must

also configure Analyzer Resources, even though Analyzer software is

not supported. To configure the Analyzer, click on the Analyzer

Resources button. In the Setting based on list, select Basic

Configuration 0001 and click on the Change Setting... button to assign

interrupt and address space resources to the Analyzer.

Does the GPIB Analyzer software work with the AT-GPIB/TNT+

interface in Windows NT?

No, the Analyzer functionality is currently not supported. However, you

can use your AT-GPIB/TNT+ as an AT-GPIB/TNT (PnP), provided that

you select both Controller and Analyzer Resources.
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When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify

instrument communication, troubleshoot problems, and develop your

application. For more information, refer to Chapter 6, Win32 Interactive

Control Utility, in the NI-488.2M User Manual for Windows 95 and

Windows NT.

How do I use an NI-488.2M language interface?

For information about using NI-488.2M language interfaces, refer to

Chapter 3, Developing Your Application, in the NI-488.2M User Manual

for Windows 95 and Windows NT.

What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic online help, or refer to the getting started manual, to

troubleshoot specific problems. If you have already completed the

troubleshooting steps, fill out the support forms in Appendix C, Customer

Communication, and contact National Instruments.

How do I communicate with my instrument over the GPIB?

Refer to the documentation that came from the instrument manufacturer.

The command sequences you use are totally dependent on the specific

instrument. The documentation for each instrument should include the

GPIB commands you need to communicate with it. In most cases, NI-488

device-level calls are sufficient for communicating with instruments.

Refer to Chapter 3, Developing Your Application, in the NI-488.2M User

Manual for Windows 95 and Windows NT, for more information.

Can I use the NI-488 and NI-488.2 calls together in the same

application?

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call

fails, the ERR bit of ibsta is set and an error code is stored in iberr.

For more information about global status variables, refer to Chapter 3,

Developing Your Application, in the NI-488.2M User Manual for

Windows 95 and Windows NT.
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What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the

Diagnostic test. Also, make sure you have filled out the technical support

form in Appendix C, Customer Communication.
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Customer Communication

C
Appendix

For your convenience, this appendix contains forms to help you gather the information necessary to
help us solve technical problems and a form you can use to comment on the product documentation.
When you contact us, we need the information on the Technical Support Form and the configuration
form, if your manual contains one, about your system configuration to answer your questions as
quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
quickly provide the information you need. Our electronic services include a bulletin board service,
an FTP site, a Fax-on-Demand system, and e-mail support. If you have a hardware or software
problem, first try the electronic support systems. If the information available on these systems does
not answer your questions, we offer fax and telephone support through our technical support
centers, which are staffed by application engineers.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions on
how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere.com, as your password. The support files and
documents are located in the /support directories.



Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone at
(512) 418-1111.

E-Mail Support (currently U.S. only)

You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 5734815 03 5734816

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Fax ( ____  ) _________________________ Phone ( ____ ) ___________________________

Computer brand ___________________ Model ______________ Processor ________________

Operating system (include version number) ____________________________________________

Clock Speed ________ MHz RAM _________ MB Display adapter ________________

Mouse ____ yes _____ no Other adapters installed _____________________________

Hard disk capacity ________  MB Brand ____________________________________________

Instruments used __________________________________________________________________

National Instruments hardware product model _____________________ Revision ____________

Configuration ____________________________________________________________________

National Instruments software product ___________________________ Version ____________

Configuration ____________________________________________________________________

The problem is ___________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

List any error messages ____________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

The following steps will reproduce the problem _________________________________________

________________________________________________________________________________

________________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration,
and use this form as a reference for your current configuration. Completing this form accurately
before contacting National Instruments for technical support helps our applications engineers answer
your questions more efficiently.

National Instruments Products

AT-GPIB/TNT (PnP) Board and Revision Number _______________________________________

NI-488.2M Software for Windows NT Revision Number on Disk  __________________________

Programming Language Interface Version  _____________________________________________

Shield Ground Connected to Logic Ground (yes or no)  ___________________________________

Board Settings:

Base I/O

Address

Interrupt

Level

DMA

Channel

gpib0                                                             

gpib1                                                             

gpib2                                                             

gpib3                                                             

Other Products

Computer Make and Model  ________________________________________________________

Microprocessor  __________________________________________________________________

Clock Frequency  _________________________________________________________________

Type of Monitor Card Installed  _____________________________________________________

Windows NT Version  _____________________________________________________________

Application Programming Language (Microsoft C, and so on)  _____________________________

Other Boards in System  ___________________________________________________________

Base I/O Address of Other Boards  ___________________________________________________

Interrupt Level of Other Boards  _____________________________________________________

DMA Channels of Other Boards  _____________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your AT-GPIB/TNT (PnP) and the GPIB Software for Windows NT

Edition Date: June 1997

Part Number: 321675A-01

Please comment on the completeness, clarity, and organization of the manual.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

Thank you for your help.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Phone ( ____  ) ________________________  Fax ( _____ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX  78730-5039



© National Instruments Corporation G-1 AT-GPIB/TNT (PnP) for Windows NT

Glossary

Prefix Meaning Value

m- milli- 10-3

c- centi- 10-2

k- kilo- 103

M- mega- 106

° degrees

% percent

A amperes

ANSI American National Standards Institute

ASIC application-specific integrated circuit

B bytes

C Celsius

CPU central processing unit

DIP dual inline package

DMA direct memory access

EISA Extended Industry Standard Architecture

EMI electromagnetic interference

FCC Federal Communications Commission

GPIB General Purpose Interface Bus

hex hexadecimal

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture
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kernel set of programs in an operating system that implements basic system

functions

m meters

MB megabytes of memory

PC personal computer

PnP Plug and Play

RAM random-access memory

s seconds

VDC volts direct current
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